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Welcome

Welcome
This award-winning application uses proprietary CalliGrapher technology to bring you
unprecedented recognition accuracy and ease of use to your Microsoft Windows®
powered portable device. CalliGrapher 7 recognizes all handwriting, be it

,

,
or

.
Additionally, you can enter equations such as

for use with CalliGrapher’s RiteCalcTM, the calculator that works with your natural
handwriting.
CalliGrapher 7 employs advanced fuzzy logic and neural net techniques that allow it to
recognize your handwriting with unparalleled accuracy and speed. In addition to
recognizing letters, numbers, and words, CalliGrapher recognizes common symbols and
various control ‘gestures’ (explained later in this manual). CalliGrapher also includes
PenCommander, which allows a user to perform many common tasks using simple
handwritten commands. The new version of CalliGrapher provides support for multiple
configurations, which can store such parameters as recognition options, keyboard
layout, custom keyboard layout, letter shapes, and ink options; customizable soft
keyboard; customizable toolbar; reduced memory footprint; improved ink flow and
recognition; and others.
Many Windows Microsoft powered devices have small, cramped keyboards or no
keyboard at all. CalliGrapher frees you from the constraints imposed by these devices
and unleashes their power.
Please visit our Web site at http://www.phatware.com to get the latest news on
CalliGrapher and other PhatWare products.
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Before Getting Started
Conventions
This manual uses several notational conventions to present information of special
importance.
NOTE: Notes highlight helpful and important things to keep in mind. These include
things like tips and tricks, shortcuts, and hints.
Lists of items, points to consider, or procedures that do not need to be performed in a
specific order appear in bullet format:
 Item 1
 Item 2
Procedures that must be followed in a specific order appear in numbered steps:
1. Perform this step first
2. Perform this step second
Specific keyboard keys are depicted in square brackets and are capitalized, for
example: [ESC]. If more than one key should be pressed simultaneously, the notation
appears as [KEY1]+[KEY2], for example [ALT]+[F4].
Buttons and knobs are depicted in round brackets and are capitalized and italicized,
for example: {RESET}.
NOTE: The notation [tap] signifies a stylus or finger tapping a touch screen.
Screen prompts are displayed in bold Courier font, for example: Start
Items you must type appear in standard Courier font, for example:
cd\letters\business\legal [ENTER]

Manual Layout
This manual is laid out as follows:
 Part One - Getting Started: This part details the CalliGrapher features, system
requirements, and installation process.
 Part Two – CalliGrapher Tutorials: Many people prefer to learn by doing. This part
includes a few tutorials to help you get up and running with CalliGrapher quickly.
Once you have finished the tutorials, you will want to read the reference chapters,
which explain all of CalliGrapher’s many features. Of course, you may also choose
to read the rest of the manual first and do the tutorials later.
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 Part Three – CalliGrapher Reference: This part provides detailed instructions on
using the CalliGrapher functions
 Part Four - Customizing CalliGrapher: Instructions on customizing CalliGrapher
to suit your individual needs and preferences.
 Part Five - PenCommander Reference: This chapter explains how to create
custom PenCommands.
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Part One: Getting Started
This chapter details the CalliGrapher 7 features, system requirements, and installation
process.

CalliGrapher Features
CalliGrapher is a powerful handwriting recognition engine. Some of its advanced features
include:
 Natural handwriting recognition: CalliGrapher recognizes print, cursive, and mixed
script as well as arbitrary symbol strings and control ‘gestures’.
 Immediate usability: Unlike many handwriting recognition programs, CalliGrapher is
ready to run right out of the box with no training required. You can, however,
customize CalliGrapher to your personal handwriting style, thereby increasing
CalliGrapher’s already superb accuracy and speed.
 Built-in dictionary: CalliGrapher recognizes words from its integrated dictionaries. This
includes a main English dictionary containing approximately 100,000 words and a
custom user dictionary. CalliGrapher also recognizes non-vocabulary words like
personal names, geographical names, and arbitrary handwritten symbol strings.
 CalliGrapher Configuration Manager: Use the Configuration Manager to change various
CalliGrapher settings and to create and edit recognition profiles. You can switch
between recognition configurations by using the Configuration gesture or tapping the
Configuration button in the CalliGrapher toolbar.
 CalliGrapher Full Keyboard: This virtual keyboard gives you all the functionality of a
built-in keyboard when you cannot access the keyboard on your mobile device, or even
when your mobile device has no keyboard at all.
 Customizable keyboard: You can choose any characters, punctuation signs, or
navigation buttons to appear on a 24-key customizable keyboard.
 RiteCalc handwriting calculator: Simply write an equation, and let RiteCalc do the
math.
 Extensive correction interface: By pointing out CalliGrapher’s mistakes, you can
improve its performance.
 Spell Checker: This feature works with practically any application for Microsoft
Windows-powered mobile devices.
 Customizable Toolbar: Choose from 36 buttons to appear on the 10-button CalliGrapher
toolbar.
 PenCommander: Write a word and draw a circle around it to launch an automated
script (PenCommand). Using PenCommands, you can perform a wide spectrum of tasks
from simple text substitutions and launching applications to calling a function from any
system or user-defined DLL. You may use many pre-defined PenCommands that are
included with CalliGrapher and may also define your own in order to automate
frequent tasks and create new functionality for your mobile device.
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 Multiple Language Support: In addition to English, CalliGrapher supports handwriting
recognition in Danish, Dutch, French, German, Italian, Norwegian, Portuguese
(Brazilian and European), Spanish, and Swedish. Language Packs are sold separately.
To order any or all of the Language Packs, go to our Web site at
http://www.phatware.com.
NOTE: If you would like to have CalliGrapher support another Western European language
in the future, email us at info@phatware.com.

System Requirements
CalliGrapher requires the following minimum configuration:
♦

Microsoft Windows-powered Pocket PC 2000, Pocket PC 2002, Pocket PC 2002
Phone Edition, Pocket PC 2003/2003SE, and Pocket PC 2003/2003SE Phone Edition.
Note: CalliGrapher 7 does not support older models of Pocket PCs (a.k.a. PalmSize PCs) and Handheld PCs, such as Jornada 720. CalliGrapher 6 will continue to
support Handheld PCs.

♦

Microsoft Windows CE 3.0 or later.

♦

Approximately 2.8MB of the free storage space on the device.

♦

Windows-powered desktop PC or laptop with ActiveSync 3.7 or later is required for
installation


If you do not have a PC with ActiveSync 3.7 or later installed, you can
download CalliGrapher as a .cab file and install it directly on your mobile
device. Visit PhatWare’s download page at http://www.phatware.com/indexdownload.html

Please note that the above represents minimum requirements only. CalliGrapher performs
better on systems exceeding the listed requirements.
NOTE: If using the new antialiasing feature, it will work reliably on Pocket PC with XScale
300MHz or faster. Not recommended for slower devices.

Installing CalliGrapher
1. Connect your mobile device to your host PC and establish a partnership using Microsoft
ActiveSync.
2.

Remove any previous version of CalliGrapher from your Pocket PC. CalliGrapher will
not install if it detects an older version present on your Pocket PC.

3.

If you’ve downloaded CalliGrapher from the Internet as a single executable installation
file (calligrapher7.exe), run this file.

4.

If you’ve downloaded CalliGrapher from the Internet as a zip file, unzip the archive
into a temporary folder on your desktop computer and run the setup.exe program.

5.

Follow the on-screen installation instructions to install CalliGrapher.

6.

Reset your mobile device when installation is completed.
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Registering CalliGrapher
When you run CalliGrapher for the first time the Register CalliGrapher dialog box
will appear (see picture below). If you have already purchased CalliGrapher, please enter
the registration code* into the edit field and tap the Register button. If you
downloaded a 30-day free trial version of CalliGrapher 7, just tap the Not Now button.
While using the CalliGrapher in the trial mode, this dialog box will appear every time you
start CalliGrapher until you enter the registration code. After the trial period expires,
CalliGrapher will no longer work and you will be able to access the Register
CalliGrapher dialog box only, until you enter the valid registration code.

Register CalliGrapher dialog box
* The registration code is located in the purchasing confirmation email, which is
automatically sent to you, only when you purchase the product. If you have
purchased CalliGrapher in a retail box, the registration code can be found on the CDROM cover. The Registration code is a case-sensitive alphanumeric string with no
spaces inside. If you have problems finding the registration code, please contact
PhatWare technical support.
If you have downloaded and used the trial version of CalliGrapher and then decided to
purchase it, you do not need to download or reinstall CalliGrapher. After you receive your
registration code, restart CalliGrapher and when the Register CalliGrapher dialog box
appears, enter the code in the space provided and tap the Register button.
Important! It is imperative that you keep the CalliGrapher Registration Code in a safe
place. You will need it for future product upgrades and to contact product technical
support. We strongly recommend filling out and submitting the Product Registration Form
on our web site at http://www.phatware.com/register/ to ensure that you are registered
with PhatWare Corp.

3

CalliGrapher 7

Getting Started

Launching CalliGrapher
The easiest way to launch CalliGrapher is to select CalliGrapher from the list of input
methods. Tap the
arrow in the right-bottom corner of the screen and select
CalliGrapher from the popup menu. Alternatively you can launch CalliGrapher by going to
Start>Programs> CalliGrapher and tapping the CalliGrapher icon. The pen
icon appears in the Windows taskbar. Tapping the icon activates CalliGrapher and opens
the customizable toolbar.

You can customize the icons that appear in the toolbar. For more information, please
refer to the Customizing CalliGrapher section, below.

Removing CalliGrapher
1. Disconnect the mobile device from the Desktop PC (if connected).
2. From the Start menu, choose the Settings item, then under the System tab, tap on Remove
Programs.
3. When the Remove Programs dialog box appears, locate the PhatWare CalliGrapher entry in
the list box.
4. Tap on it to select it.
5. Tap the Remove button to remove the CalliGrapher application.
6. Reset your mobile device to finish the uninstallation.
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Tips to increase the recognition quality
 You will have the best recognition quality when using the default letter shape settings.
Disabling too many shapes will decrease the recognition quality. There is only one reason to
disable a certain shape of a certain letter, which is if calligrapher recognizes this letter
incorrectly because you wrote its shape similar to another letter. For example, if your "o" is
recognized as "u", you can try to disable some shapes for "o" or for "u", or for both. However, if
you disable too many shapes you will decrease the recognition quality.
 When you click on the selected shape in the Letter Shape Selector it will redraw the letter
showing the direction in which you should move your pen. The direction of the pen strokes is
as important as the shape.
 Try to write bigger characters. The minimum recommended size of your handwritten
characters should be equivalent to size 16 (or bigger) of the Tahoma font. (To get an idea how
big it is, run Pocket Word, select the Tahoma size 16 font and write “something”).
 Upper case characters should be at least twice as big (or bigger) as the lower case characters.
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Part Two: CalliGrapher Tutorials
These tutorials cover a few of the most common ways in which people use CalliGrapher.
To use them, simply turn on your mobile device and follow along! Be sure to read the rest
of the manual for complete details on how CalliGrapher works once you are finished with
the tutorials.
NOTE: The tutorials in this manual are designed to be generic. CalliGrapher will function
with practically any text editing software.

Tutorial One: The Basics
This tutorial introduces you to some of Calligrapher’s basic features. Simply follow the
steps outlined below to experiment and see for yourself some of the many things you can
do using CalliGrapher:

1. Launch both your text editing application and CalliGrapher on your mobile device.
2. Make sure the pen icon is highlighted (tap it if necessary) and write the following on
your screen. Try to write a bit more neatly that normal, and use larger letters until
you get used to how the program responds to your input. This will not affect
CalliGrapher’s accuracy; rather, it will help introduce you to the program. Write The
quick brown fox jumps over a lazy dog.

3. Select jumps over a lazy dog and use the Backspace gesture as shown below.
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4. The selected text is erased.

5. Now, insert a carriage return (equivalent to pressing [ENTER]) by using the Return
gesture. Make sure that the horizontal part of the gesture is at least twice as long as
the vertical part.
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6. Note that the cursor moves down one line.

7. Now use the Erase gesture (straight line from right to left) to erase the carriage return
and move back to the top line.

8. Tap the word brown between the r and the o to position the cursor, and use the Space
gesture. The space gets inserted.
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9. The space is added.

10. Use the Erase gesture to remove the space.
11. Select the word quick and use the Case Change gesture.
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12. This turns the word quick to QUICK.
13. To undo the previous action, use the Undo gesture.

14. The word reverts to lower case.

10

CalliGrapher 7

CalliGrapher Tutorials

15. You may use your stylus to change individual letters. For example, highlight the letter
b in brown and write the letter c.

16. The word changes.
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17. You may also select and replace entire words. For example:

18. This produces the following result:
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Tutorial Two: Correcting Text
What if you make a mistake while writing? No problem. CalliGrapher allows you to correct
mistakes quickly and easily as shown in this tutorial:

1. Launch both your text editing application and CalliGrapher on your mobile device.
2. Write “The quick brown fox”. If CalliGrapher recognizes the above text correctly,
keep writing until it mis-recognizes a word, for example:
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3. Highlight the sentence and use the Correction gesture to launch the Correction
Window. Be sure to enter the gesture correctly (move the stroke from left to right and
make the gesture large, with the right leg much higher than the left one as shown
below).

4. The Correction Window appears.

5. Tap the word brown and note that a caret appears where you tapped; this is where
changes will occur. Either tap the caret or double-tap the selected word to bring up a
list of suggested replacements.
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6. If the correct word is in the list (in this case grown), select it to make your changes.
7. If the correct word is not in the list, simply correct the misspelled word manually by
highlighting the incorrect letter and writing the correct letter.

8. Tap OK once you are finished making changes.
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Tutorial Four: Beyond the Basics
Our fox from the previous tutorials is not done yet. In this tutorial, you learn more about
CalliGrapher’s ‘gestures’ and spell-checking capabilities.

1. Launch both your text editing application and CalliGrapher on your mobile device (or
simply continue from the previous tutorial).

2. Write or type the following sentence: The quick broun fox jumps over a lazy
dog. The misspelling is intentional.

3. Use the Correction gesture.
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4. Because you have no text selected, the entire sentence will transfer to the Correction
window.

5. Double-tap the misspelled word (or tap the caret) to bring up the list of suggested
replacements.
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6. Select the desired word, which replaces the word in your sentence.

7. Select the word brown by drawing a single line across it from left to right and holding
for a moment.
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8. The word brown is selected.

9. Now erase the word by drawing a single line from right to left. The result appears
below:
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10. To capitalize a letter, draw a single vertical line from the base of the letter whose
case you wish to change to the top.

11. The result is as follows:
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12. To close the Correction window and accept the edits, tap OK. Tap X to close the
Correction window and reject your edits.

Tutorial Five: PenCommander
PenCommander technology adds a whole new dimension to CalliGrapher by allowing you to
perform a wide variety of simple and complex tasks simply by writing them. No more
tapping through endless menus and icons! This tutorial introduces you to some of the many
things you can do using PenCommands:
1. Enter some text in a document, then write the word all and draw a circle around it.
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2. The text is selected. Now write cut and draw a circle around it.

3. The text is cut from the current document and placed in the Windows clipboard. To
restore it, simply write paste and circle it.

4. The text reappears:
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Please refer to the sections CalliGrapher Reference and PenCommander Reference, below,
for complete information on how PenCommander can revolutionize the way you use your
PDA.
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Part Three: CalliGrapher Reference
This part explains how to use CalliGrapher’s many features and how to customize the
software to suit your individual needs and preferences.

CalliGrapher Toolbar
CalliGrapher has a customizable toolbar that appears in the CalliGrapher panel. The
default icons appear below.

The toolbar page of the CalliGrapher Settings dialog box allows you to select the buttons
that should appear in the toolbar. You can choose 10 out of 36 possible buttons to be
displayed; the table below lists the available buttons.

Show/hide the CalliGrapher keyboard. Please refer to the CalliGrapher
Keyboard section below.
Show/hide the custom keyboard. Please refer to the CalliGrapher
Keyboard section below.
Open Configuration Manager. Allows you to change many settings such as
adding and editing multiple configurations, each able to use a different
recognition engine, dictionary, keyboard, ink color and ink width. You
can also change other usability options, customize the toolbar,
enable/disable orientation and recognition modes.
Run PhatPad.
Run PenCommander. Launches the PenCommand Editor. Please refer to
the PenCommander Reference section below.
Open Letter Shape Selector. Please refer to the Letter Shape Selector
section below.
Open the Correction Window to correct the selected text. Please refer to
the Correcting Text section below.
Open the Correction Window to correct all text. Please refer to the
Correcting Text section below.
Undo
Cut
Copy
Paste
Select all
Insert tabulation
Insert space
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Insert line feed
Backspace
Change case
Create PenCommander command from the selected text.
Turn CalliGrapher sounds on/off
Turn recognition on/off
Turn PenCommander on/off
Select Recognition mode. There are four recognition modes available:
Normal (a): Supports all kinds of writing (default)
Capitals (A): Converts all writing to upper case
Numeric (12): Only recognizes digits, punctuation, and selected letters
(such as AM, PM, etc.)
Internet (@): Will not insert any spaces, which is useful when writing an
internet or email address.
Select writing orientation. The arrow points perpendicular to the
currently selected writing direction. You may choose from six possible
orientations.
NOTE: To enhance recognition accuracy, be sure to write and gesture in
the selected direction.
Select configuration. If more than one configuration is available, displays
the list of configurations. If only two configurations are installed, will
toggle between both. The configuration icon identifies the currently
selected configuration.
Show CalliGrapher Help
Close CalliGrapher
Escape key
Delete key
Navigation keys
Run PenCommand (or display popup menu with the selected
PenCommands)
You may enable or disable the CalliGrapher Toolbar using the General tab within the
CalliGrapher Settings dialog.

CalliGrapher Keyboard
CalliGrapher includes a soft keyboard, which provides all of the functionality of a hardware
keyboard.
There are two ways to open the CalliGrapher keyboard:
 Tap the Keyboard icon in the toolbar
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 Draw the Quick Correct gesture when no text is selected to open the Custom Keyboard.
If the CalliGrapher keyboard was invoked by tapping the Keyboard icon, the following
CalliGrapher Keyboard appears:

You can drag the keyboard to anywhere on the screen. Simply tap the key of your choice.
It will have the same effect as typing the same key using a built-in keyboard. If you are
typing words, you will see a list of suggestions appear in the pull-down window at the top
of the keyboard (if this option is selected in the CalliGrapher Configuration dialog box).
This can help save time when typing common words.
If you change the CalliGrapher configuration while the keyboard is visible, the keyboard
will automatically change to the layout selected for the new configuration. Shown below is
the French keyboard:

The keyboard disappears once you select a punctuation symbol unless you use the Pin
button in the upper left corner to make it stay.
The special function keys (light blue) remain pressed until you press another key, with the
exception of the Caps key, which remains pressed until you toggle it off.
This allows you to use other functions. For example, you could tap [ALT], which remains
pressed, followed by [F] ([ALT] pops up after you press [F]).
You can perform standard calculations using the CalliGrapher Keyboard. Type in a
mathematical expression followed by the equal sign (=) and see the result appear in the
suggestion window (e.g. 23+7*8=). To enter the result into the document, simply tap
inside the suggestion window. Please refer to the RiteCalc section below for more details
about the functions and limitations of the calculator feature.
In addition to entering text or numbers, you may need to use the CalliGrapher Custom
Keyboard to add a punctuation symbol to text that has been already written. To open the
Custom Keyboard use the Quick Correct gesture (please refer to the Quick Correct Gesture
section below) with no text selected, or tap on the Custom Keyboard icon in the toolbar.
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The topmost row of the Custom Keyboard window is not customizable and shows the
following three buttons (from left to right):
 Pin button: The keyboard disappears once you tap a symbol button unless you use the
Pin button to make it stay.
 The Keyboard button opens the full keyboard.
 Tapping the Close button in the upper right corner closes the CalliGrapher Custom
Keyboard. Upon reopening, the keyboard will remember its last position.

Creating and Editing Text
When in Recognition Mode, CalliGrapher interprets your drawing on the screen as
handwriting. CalliGrapher recognizes the handwriting and sends the results to the
currently active application window. Single and double taps will still work, meaning you
can access menus, icons, and windows while in Recognition Mode. When CalliGrapher is in
Recognition Mode, the pen icon in the Windows taskbar is highlighted and the Input Method
selector button is depressed.
Use one of the following methods to enter Recognition Mode:
 If CalliGrapher is not running, select CalliGrapher from the Input Method selector
popup menu. Tap the Input Method button if CalliGrapher is selected as a current
method but the button is not depressed and recognition mode is disabled.
 When on the Today screen and CalliGrapher is already running, tap the pen icon
the Windows taskbar.

in

 Tap CalliGrapher in the Programs Dialog found in the Start menu.
You may select text while in Recognition Mode by following the instructions contained in
the Selecting Text section below.
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In addition to its remarkable recognition capabilities, CalliGrapher features some advanced
editing tools.

Selecting Text
In Recognition mode CalliGrapher attempts to recognize any pen input as handwriting.
Therefore, you need special means of telling CalliGrapher that you plan to select or drag
text. There are two ways to do this:
 Tap and hold the stylus still for a moment until you hear a sound. At the sound,
CalliGrapher suspends recognition activities, and your stylus may be used as usual.
Drag the line across the text you wish to select, in the same way as you would with the
Eraser tool.
 Draw a line across the desired text and then hold the pen or mouse for a moment. The
desired block will be highlighted, and the line you have drawn to select the text will
disappear.

Control Gestures
You may edit text either in the active application’s window, or in CalliGrapher’s own
Correction Window. For information on using the Correction Window, please refer to the
Correction Window section below.
To edit text in the active application’s window, use control ‘gestures’, which are specially
shaped strokes that signal CalliGrapher to perform the appropriate edit function.
You may use gestures for common operations such as [ENTER], [SPACE], and
[BACKSPACE]. Many gestures are positional, meaning that their location on the screen
determines the text affected by the gesture. If, however, the starting point of the gesture
does not correspond to a specific place in a paragraph of the text, the desired action will
be applied at the current cursor location.
You do not need to draw the arrows that appear on the gesture depictions below. They
merely serve to illustrate the end point of the particular gesture. Gray arrows next to a
gesture depict the proper method of drawing the gesture.
Return Gesture
This gesture is the functional equivalent of pressing [ENTER]. This action
occurs at the current cursor location.
Space Gesture
This gesture is the functional equivalent of pressing [SPACE]. This action
occurs at the current cursor location.
Tab Gesture
This gesture is the functional equivalent of pressing [TAB]. This action
occurs at the current cursor location.
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Backspace Gesture
Draw the line from right to left. This gesture is the functional equivalent of
pressing [BACKSPACE].
Correct Gesture
This gesture only works outside the CalliGrapher Correction Window. It opens the
Correction Window and copies the selected text into it. Holding the pen or mouse
for a moment at the end of the gesture copies the entire document into the Correction
Window. This operation is particularly useful for spell checking documents.
For more information on correcting text, please refer to the Correcting Text section,
below.
Quick Correct Gesture

Use this gesture to:
 Add a selected word to the dictionary
 Open the Correction Window (see the following section)
 If no text is selected, the Quick Correct gesture opens the CalliGrapher Keyboard
in punctuation layout (see above).
Case Change Gesture

Use this gesture over any letter in the Correction Window to change its case. Begin
the gesture over the desired letter or symbol, and draw it straight upward.
In other applications, this gesture changes the case of a selected word or block of text. It
can also be used to change the case of the letter immediately after the cursor.
Configuration Gesture

This gesture changes the active configuration. If CalliGrapher has only one
configuration, the gesture has no effect. If two configurations exist, the gesture toggles
between the configurations. In case of more than two configurations, the gesture either
selects a configuration that is next in the list or displays the drop-down menu if the
corresponding option is selected in CalliGrapher settings.
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Undo Gesture

Undoes the previous action. It is the equivalent of pressing [CTRL]+[Z] in most
Windows applications.
Copy Gesture

Copies selected text to the Windows clipboard while leaving the original text in
place. It is the equivalent of pressing [CTRL]+[C] in most Windows applications.
Cut Gesture

This gesture removes selected text from the current application and places it in
the Windows clipboard. It is the equivalent of pressing [CTRL]+[X] in most Windows
applications.
Paste Gesture

This gesture copies text previously placed in the Windows clipboard into the current
application while leaving the text available in the clipboard for repeat pasting, if desired.
It is the equivalent of pressing [CTRL]+[V] in most Windows applications.

Correcting Text
CalliGrapher provides convenient means for text correction both in its own Correction
Window and directly in other applications’ windows. Use the ‘Correct’ gesture to copy
selected text and ‘Correct All’ to copy all document text to the Correction Window.
The Correction Window allows you to use positional gestures, add or remove text, and
directly overwrite letters.

Correction Window
When invoked, the Correction Window appears (see picture below) with your selected text
copied into it.
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The Correction Window toolbar has several buttons that aid you in correcting your text:
Cut
Copy
Paste
Undo/Redo: Tapping this button alternates between undoing and
redoing the previous action.
Select All: Highlights all the words and letters in the Correction
Window.
Spacebar: Inserts a space at the cursor position.
Backspace: Deletes a character to the left of the cursor position.
Spell-checker: Highlights all words that do not appear in
CalliGrapher’s internal dictionaries. This is useful for spell checking
and finding non-standard terms and jargon.
Record Changes (OK): When you are finished correcting the selected
text, tapping this button places the corrected text back into your
document and closes the Correction Window.
Close Correction Window (Cancel): Click this button to close the
Correction Window. You will lose all changes.
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Overwriting Text
You may correct words by writing the correct letter directly on top of the misspelling, as
shown below:

Word before correction

Overwriting the misspelling

Corrected word

Correction Window Pop-Up Menus
The Correction Window contains different types of context menus. Tapping the cursor
when text is not selected brings up the Word menu. A single tap on the cursor on a word
that is selected brings up the Selected Text menu. Double-clicking on an empty area
brings up the Non-Text Menu.

Word Menu
 Alternative Words: This part of the menu lists recognition alternatives or words
suggested by the spell-checker.
 AutoCorrector: You can add a word from the list of suggested alternatives to the
Auto Corrector list found in the Configuration Manager. See the Auto Corrector
section below.
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 Add To Dictionary: Adds the current word to the user dictionary. This menu item
displays when the currently selected word is absent from both the user and main
dictionaries.
 Case Switch: changes capitalization of the selected character
 Add Space: adds a space in front of the selected character
Selected Text Menu
 Delete Selected: removes selected text and replaces it with a space
 Replace Selected with Space: inserts a space in place of the selected text
 Case Switch: changes the capitalization of the whole selection
 Copy Selected: copies the selected text to the clipboard
 Paste: inserts the clipboard contents in place of the selection
Non-text Menu
 Erase All: clears the Correction Window
 Undo/Redo: restores text to its state before current correction
 Copy All: copies contents of the Correction Window to the clipboard
 Paste: inserts clipboard contents in the Correction Window

Adding Words to the User Dictionary
If a word is properly spelled but not found in the main or user dictionaries, you may add
the word to the user dictionary by selecting the word and using the Quick Correct gesture.
In this case the CalliGrapher pop-up menu will have an Add to Dictionary option.
Choose it and the selected word will be added to the dictionary. (If the word is already in
the dictionary, this menu item will not appear.) You can also go to the Correction Window
or add a new word to the Auto Corrector Word List this menu. See the Auto Corrector
section below.
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Using the Spell Checker
To spell check part of a document, select the desired text and draw the Correct gesture to
launch the Correction Window containing your selected text. Make sure that the
Highlight Non-dictionary Words button is active. Words not in the CalliGrapher
dictionaries appear highlighted and underlined. Make the required corrections and then
press the Record Changes button (described in the Correction Window section above) to
insert the corrected text back into the document.
To spell check the whole document, draw the Correct All gesture or tap on the Correct
All Text button to bring all the text in the document to the Correction Window.

RiteCalc
RiteCalc seamlessly integrates a basic calculator into CalliGrapher’s recognition functions.
When using Recognition Mode, simply enter a formula as a single sentence with the syntax:
<operand1> <operation> <operand2>…=
where <operand1> and <operand2> are numbers, and <operation> is the function being
performed. You may use multiple terms with the above syntax in one formula (nested
operations enclosed in brackets are not allowed). Valid operands include any whole or
decimal number, with up to two digits after the decimal point and seven digits before it.
RiteCalc calculates the result using the standard mathematical hierarchy: multiplication
before division before addition before subtraction. For example 2*3+5= will yield 11
(2*3=6, 6+5=11).
Valid operations are:
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 Addition: +
 Subtraction:  Multiplication: * or x.
 Division: /, :, or ÷
To use RiteCalc, simply write or type an equation using the CalliGrapher keyboard:

The text will appear in your application as:
32.6+74= 106.60

PenCommander
PenCommander technology allows you to perform many functions (PenCommands) such as
editing or inserting text, opening applications, and virtually any function by simply writing
a word command and drawing a circle around it. Please refer to the table below for a list
of pre-recorded PenCommands included with CalliGrapher 7.
In addition to the pre-recorded PenCommand commands, you may create your own. These
may be simple or complex. Please refer to the Part Five: PenCommander Reference
section below for details on creating your own PenCommands.
You may also embed the Text Only PenCommands (see table below) in your writing, just as
you do with control gestures.

List of CalliGrapher PenCommands
The following table lists the PenCommands included with CalliGrapher 7. They are supplied
mostly as samples to become the basis for your own set of PenCommands.
NOTE: Some of the provided PenCommands may not work in some text fields and applications.

PenCommand
Name

Function

Text Substitution PenCommands
addr

Types in a sample address.

btw

Types in “by the way”.

e

€
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PenCommand
Name

Function

sign

Inserts sample signature information.

smile

:-)

sinc

Types “Sincerely Yours”, current date and time.

Internet Support
com

Types http://www..com and sets the cursor between the dots.

edu

Types http://www..edu and sets the cursor between the dots.

ftp

Types ftp://ftp.

ie

Starts Pocket Internet Explorer application.

mail

Starts Inbox (Pocket Outlook Mail) application.

msg

Starts MSN Messenger application on Pocket PC 2002.

org

Types http://www..org and sets the cursor between the dots.

www

Types http://www.

Date and Time
date

Types in the current date using the current locale settings.

time

Types in the current time using the current locale settings.

Text Edit PenCommands
all

Select all.

bold

Changes the style of the selected text to bold ([CTRL]+[B]). Not
supported by Pocket Word on Pocket PCs.

copy

Copies the selected text to clipboard([CTRL]+[C]).

cut

Cuts the selected text to clipboard ([CTRL]+[X]).

find

Finds text [CTRL]+[F].

ital

Changes the style of the selected text to italic ([CTRL]+[I]). Not
supported by Pocket Word on Pocket PCs.

paste

Pastes data from the clipboard ([CTRL]+[V]).
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PenCommand
Name

Function

stat

Displays statistics of the selected text.

under

Changes the style of the selected text to underline ([CTRL]+[U]).
Not supported by Pocket Word on Pocket PCs.

undo

Undo ([ALT]+[BKSP]). Not on pocket PCs.

Application Launch PenCommands
calc

Starts Windows Calculator program.

cln

Starts Calendar application.

ex

Starts Pocket Excel application.

read

Starts Microsoft Reader application.

run

Prompts you for a program name, then runs that program.

sol

Starts Solitaire game.

task

Starts Tasks application.

word

Starts Pocket Word application.

CalliGrapher-related PenCommands
clip

Places clipboard contents into string #9.

cor

Opens the Correction Window (equivalent to the Correct gesture).

lss

Starts Letter Shape Selector.

key

Show/hide CalliGrapher keyboard.

ck

Show/hide CalliGrapher Custom keyboard.

tb

Show/hide CalliGrapher toolbar.

opt

Opens the CalliGrapher Options dialog.

spell

Selects all text and opens the Correction Window.

RecMode

If a numeric parameter is used, selects the specified recognition
mode (0 – Normal, 1 – Capital, 2 – Numeric, 3- Internet). If used
without a parameter, selects the next recognition mode.
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PenCommand
Name

Function

RecDir

If a numeric parameter is used, selects the specified writing
direction. If used without a parameter, selects the next
recognition direction.

cfg

Selects the specified configuration, or if a configuration name is
not present, selects the next configuration in the list.

ScrMode

Changes the screen orientation. If a numeric parameter is used,
selects the specified orientation (0 - Portrait mode, 1 - Righthanded landscape mode, 2 - Upside-down portrait mode, 3 - Lefthanded landscape mode), otherwise rotates the screen 90 degrees
clockwise.
This command is only supported on the latest models of Pocket PC
2003 that natively support landscape mode. Some older devices
also could be upgraded to the latest version of the Microsoft
Windows Mobile software that supports screen rotation. If you are
not sure whether your Pocket PC supports landscape mode,
contact the manufacturer of the device.

Math functions (brings up a math function window with the result)
pow

Brings N to the power of P, where N is the first number in the
selected text and P is the second one.

root

Calculates the square root of N, where N is the number in the
selected text.
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Part Four: Customizing CalliGrapher
This section describes how to set CalliGrapher to suit your individual needs and
preferences. There are several ways to customize CalliGrapher: Input Settings and the
Configuration Manager, from which you can set multiple CalliGrapher configurations and
other Calligrapher Settings such as customizing your toolbar and enabling/disabling your
orientations and recognition modes.

Configuration Manager
To open the Configuration Manager, either tap on the Configuration Manager icon
from with the Start/Programs dialog or with CalliGrapher running, tap on the
Configuration Manager icon in the toolbar. You can also tap on the Options menu
item, and then tap on the Options button with CalliGrapher set as the Input method.
The Calligrapher Settings window appears. It has the following tabs:
 Configurations: Allows you to create, modify, and delete multiple CalliGrapher
configurations. For each configuration you are able to customize your writing
recognition settings, dictionaries, keyboard, and line thickness and color.
 General: General CalliGrapher options tab.
 Margins: Allows you to set CalliGrapher recognition margins (in pixels).
 Toolbar: Allows you to customize the toolbar to gain quick access to your most
commonly used commands.
 Buttons: Allows you to assign PenCommands to Pocket PC hardware buttons.
 Advanced: This tab allows you to enable and disable various handwriting orientations
and recognition modes.
 About: Provides information about your installed CalliGrapher version.

Configurations Tab
The Configurations Tab shows your current configurations. From this tab you can add,
edit or delete the configurations.
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To add a new configuration, tap on the Add button. The New Configuration window
appears. From here you can type or write a new configuration name and use default
configuration settings for your new configuration, or copy settings from an existing
configuration.

Calligrapher Configuration
To edit an existing configuration, tap the Edit button. This will bring up the
CalliGrapher Configuration window, consisting of the following tabs:
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 General: Change the configuration name and its corresponding icon.
 Recognizer: Select the recognition engine and customizes the way CalliGrapher
recognizes your writing.
 Dictionary: Select main and user dictionaries to be used by recognizer and spell
checker when this configuration is selected.
 Auto Corrector: Enables the auto corrector feature. You can also add words to the
auto corrector list.
 Keyboard: Select the layout of the main keyboard and select the keys to use for the
Custom Keyboard.
 Ink: Customize the line thickness and color.
The following section describes each tab in detail.
General Tab
From here you can change the name of the configuration and select the corresponding icon
from the drop down menu. Once this configuration is saved, you can easily activate the
configuration by selecting this icon from the toolbar.

Recognizer Tab
The Recognizer tab allows you to customize how CalliGrapher recognizes your handwriting.
The recognizer is the software module that actually recognizes your handwriting. By
selecting different recognizers, you can customize the way CalliGrapher recognizes your
writing. For example, if you write in different languages, you may wish to have different
recognizers available for use. Contact PhatWare to learn about the availability of different
recognizers.
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 Enable recognizer: Check this box to enable the recognizer, and clear it to disable.
You may select different recognizers by either typing in the full path or tapping the
Browse (…) button and using the standard Windows interface to locate your desired
recognizer.
 Add space after word/phrase: tells CalliGrapher to insert a space after each recognized
word or fragment.
 Don't add space after single letter: check this box if you do not want to add a space
after a single letter. This box is disabled if the Add space after word/phrase options is
not checked.
 Separate letters mode: This mode forces the recognizer to recognize only words
written in separate letters. Connected letters will not be recognized if writing in
script.
 Recognition delay: This option determines how long CalliGrapher should wait for you
to cross your ‘t’s and dot your ‘i’s before sending ink to recognition. If CalliGrapher
recognizes your handwriting into typed text too quickly, it might be confusing because
your writing might disappear even before you finished writing a single word. Also, you
would not have enough time to write multi-stroke letters (such as crossing the letter
‘t’). Therefore, setting an appropriate delay allows you to write comfortably. We
recommend shortening the recognition delay as you become proficient with
CalliGrapher.
 Click on the Edit Letter Shapes button to go to the Shape Selector. For more
information on how to use the Shape Selector, see the Shape Selector section below.
Dictionary Tab
While CalliGrapher is running, it may use up to two dictionaries to increase recognition
accuracy. Dictionaries are files that store lists of words. Thus, the dictionaries help the
recognizer software transform your handwriting into typed text. The main dictionary is
part of the CalliGrapher package and contains tens of thousands of frequently used words.
If you write in different languages, you may wish to use a main dictionary customized to
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the language(s) you use. Please contact PhatWare Corp. to find out what main dictionaries
are available.

You may select any valid CalliGrapher dictionary file as the main dictionary. At this time,
PhatWare Corp. is the only source of main dictionary files. Note that you cannot edit
dictionaries supplied with CalliGrapher.
 Enable Main Dictionary: The Main Dictionary box enables the main dictionary.
You may select different main dictionaries either by typing in the full path to the
desired main dictionary, or by tapping Browse and using the standard Windows
interface to locate your desired main dictionary.
 Enable User Dictionary: The User Dictionary box enables the user dictionary. The
User Dictionary performs the same function as main dictionaries. However, the user
dictionary is fully created and maintained by the user. You may select different user
dictionaries either by typing in the full path to the desired main dictionary, or by
tapping Browse (…) button and using the standard Windows interface to locate your
desired user dictionary. The default location of the user dictionary is in the My
Documents folder.
NOTE: To create a new user dictionary, you must enter the desired name for the new
dictionary.
 Suggest only dictionary words: This mode will only make suggestions that are in the
currently active dictionary(s).
 Recognize only dictionary words: This mode will only allow your handwriting to be
interpreted as words found in the currently active dictionary(s). If a user writes a word
that is not in the dictionary it will be substituted with the closest dictionary word.
 The Edit User Dictionary Button allows you to convert lists of words into custom
dictionaries for use with CalliGrapher. It may be also used for converting user
dictionaries created by the previous version of CalliGrapher to the new format.
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Tapping the button allows you to edit the user dictionary via the following window:

To add a word, type it in the field on the top of the window and tap Add. To remove a
word, select it from in list of words in the bottom field and tap Delete. Save your
changes by tapping OK, or ignore them by tapping Cancel.
Auto Corrector Tab
The Auto Corrector feature improves quality of handwriting recognition by automatically
replacing an incorrectly recognized or misspelled word with a specified alternative. Auto
Corrector searches its word list for each recognized word and, if found, replaces it with
the specified alternative (Replace With) word. Additionally, you can add new words to the
Auto Corrector word list using the Quick Correct popup menu if Auto Corrector is enabled.
See the Correction Window Pop-Up Menu section above.
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Use this dialog box to modify Auto Corrector settings.
 Enable Auto Corrector: Check this box to enable Auto Corrector.
 Enter the desired name for the Auto Corrector word list into the provided space. Tap
on the [...] button to browse for an existing file. If the specified file does not exist,
CalliGrapher Configuration Manager will prompt if you want to create a new file when
you tap OK.
 Tap the Edit Word List button to view/modify the Auto Corrector word list. See the
Auto Corrector section below.
 Fix mixed capitalization: Check this box to fix words with mixed capitalization.
 Capitalize names of days/month: Check this option if you want to always capitalize
names of days and month (English language only).

Keyboard Tab
Use the Layout drop-down box to choose between 13 pre-defined keyboard configuration
layouts for 11 Western European languages.
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Checking the Enable spell checker in keyboard box allows a list of suggested
words to appear in a small window above the keyboard as you type.

Tapping on the Custom Keyboard Button brings you to the CalliGrapher Keyboard
Editor window. Tap on a character in the list of available characters and drag it onto the
keyboard shown at the top of the dialog. You can also select a button in the layout and
drag it to a different position - when you release the pen the two buttons will swap
positions.
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This may help you in situations in which you are having difficulties because of incorrect
recognition of certain characters. The custom keyboard can be easily accessed with pen
gesture or from the toolbar.
Tap the Apply to all button if you want to use the same custom keyboard layout for all the
configurations.
Tap the Reset button to revert back to the default custom keyboard.
Ink Tab
The Ink tab allows you to assign custom properties to your CalliGrapher Recognition mode
electronic ‘ink’.
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Tap the up and down arrows in the Ink Width field to select the desired width of your
electronic ‘Ink’.
By tapping an Ink Color you can select the desired color of the ink.
Tap the Apply to All button to apply ink settings to all the existing configurations.

General Tab

The General tab contains check boxes for various options:
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 Sound on/Pen change sound on: Controls CalliGrapher sounds.
 Show menus when changing modes: Allows a list of menu options to appear when
, Recognition Mode

tapping on the Screen Orientation
icons.

, or Configuration

 Show intro screen: Allows the appearance of the Introduction Screen at CalliGrapher
startup.
 Start CalliGrapher after soft reset: If checked, CalliGrapher will be started and set as
the default input method after you reboot your device.
 Show toolbar: This option controls the display of the CalliGrapher toolbar when
CalliGrapher is active.
 Smooth ink mode (antialiasing): Allows for a smoother appearance to your
handwriting.
Note: This feature requires additional CPU power and works reliably on Pocket PC with
XScale 300MHz or faster. Not recommended for slower devices.

Margins Tab
The Margins Tab allows you to set left, right, top, and bottom margins. If you start moving
pen outside the specified margins CalliGrapher will ignore pen movements. However, after
you begin writing within the margins, you can continue writing anywhere on the Pocket PC
screen.

Toolbar Tab
The Toolbar Editor window allows you to customize CalliGrapher Toolbar. To modify the
toolbar just tap on a button in the list of available buttons and drag it onto the toolbar at
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the top of the dialog. The description of the button you selected will appear below the
toolbar. When you release the pen over a button, the button will be replaced by the one
you were dragging.

The three PenCommand buttons (
) require you to specify additional parameters
before they can be used. When you select one of the three PenCommand buttons the
Configure button appears at the bottom of the available buttons list. Tap the button to
display the Configure PenCommand Button dialog where you can select one or more
PenCommands for the button, either in simple or menu mode.
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Buttons Tab
The Hardware Buttons page allows you to assign your favorite PenCommands to the
hardware buttons. To assign a PenCommand to a button, select the button in the list and
then select the command from the Button assignment drop-down box. Select <Default> to
restore the original action of the button. Tap the Restore Defaults button to reset all the
hardware buttons to their default actions.
Note: On some devices the changes made to the hardware buttons configuration may
become active only after a soft reset.
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Advanced Tab
This window allows you to disable the screen orientations and recognition modes that you
never use by deselecting the corresponding checkbox. When disabled, the modes do not
appear in the modes menus and they also get skipped when cycling through by pressing
mode buttons on the toolbar.

About Tab
This window shows information on your currently loaded version of CalliGrapher.

Compatibility Settings
To address possible compatibility issues with third-party applications that use many system
resources, CalliGrapher provides two new options accessible via the Control Panel. Select
the Start/Settings menu command on your Pocket PC, switch to the System tab, and tap
the CalliGrapher icon. The CalliGrapher Advanced Settings dialog box will appear (see
below).
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Use native touch screen driver
Note: If this option is disabled, the native Pocket PC touch screen driver is not compatible
with CalliGrapher.
If you are experiencing any compatibility issues with CalliGrapher's touch screen driver,
you can use the native Pocket PC touch screen driver instead. To switch to the native
driver, check the Use native touch screen driver box, then soft-reset your Pocket PC. To
switch back to the CalliGrapher touch screen driver, uncheck this box.

Use small bitmaps in SIP (VGA only)
Note: This option is available only on Pocket PC devices with full-VGA screens.
By default CalliGrapher uses hi-resolution bitmaps in the input panel (SIP) toolbar on fullVGA Pocket PC devices. Pocket PC system modules such as Blue Tooth, Wi-Fi, Today Screen
plug-ins, all input methods including CalliGrapher, etc., are running in the workspace of
the same system process. If you have too many system modules enabled at the same time
(especially if you use third-party today-screen plug-ins that are known to utilize significant
GDI resources), the system process might hit its limit, and some modules will fail to load
(note that it is a system hard-coded limit and it does not depend on the available memory).
You can reduce the size of system resources required by CalliGrapher's SIP by checking the
Use small bitmaps in SIP box.
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Auto Corrector
You can modify the Auto Corrector list found in the Configuration Manager. From the
CalliGrapher Configuration Window, go to Auto Corrector Tab and tap the Edit Word List
button. See the Auto Corrector Tab section above.

To add a new word
 In the Auto Corrector Word List window, tap New in the toolbar.
 In the Add/Edit Word dialog box, enter the If CalliGrapher recognizes word and the
Replace with words in the provided spaces. Both words can be up to 40 characters
long.
 To add another word tap New in the toolbar again or tap OK when finished.
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To edit an existing word
 Double-tap on the desired word in the Auto Corrector Word List.
 Make any necessary modifications in the Add/Edit Word dialog box.
 Tap Previous or Next to browse the Word List, or tap OK when finished.

To delete a word
 Double-tap on the desired word in the Auto Corrector Word List.
 Choose the Delete toolbar menu in the Add/Edit Word dialog box.
 Confirm the deletion when prompted.
 Alternatively, you can temporarily disable unwanted word replacement, by unchecking
the Enable word substitution box.

To add a new word using the Quick Correct menu
Alternately, you can add a new word directly from the Quick Correct menu. See the
Correction Window Pop-Up Menu section above.
 Select the incorrectly recognized word in the text document and use the Quick Correct
gesture (down and up stroke; see the Quick Correct Gesture section above for more
information) to bring up the popup menu with possible alternatives.
 If you find a correct alternative in the menu, you can select it to replace the selected
word in the text document.
 If you want to add the replacement word to the Auto Corrector word list, select the
desired alternative from the Auto Corrector submenu. If CalliGrapher's recognition
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engine returns the same word again, it will be replaced with the specified alternative
while handwriting is converted to the digital text.

Shape Selector
The Shape Selector allows you to tailor CalliGrapher recognition to suit your unique writing
style. This helps to improve both the speed and accuracy of recognition. You are able to
modify shapes separately for each installed language.

You can access the Shape Selector by tapping on the Configuration Manager icon in
the toolbar, then tapping the Edit button for your desired configuration, then going to the
Recognizer tab and tapping on the Edit Letter Shapes button. To edit letter shapes
for the currently selected configuration, you can tap the Letter Shape Selector button on
the toolbar or use the lss pen command.
The Shape Selector screen presents various means of writing numbers, letters, and
common symbols. For each letter, number, or symbol, tap each possible variation to see
the animated writing pattern and check the appropriate icon in the toolbar to tell
CalliGrapher if you use that variation Often , Rarely , or Never . You may tap the
letter, number, or symbol you wish to customize, or you may use the scroll arrows to move
through the list. Close Letter Shape Selector when finished. Your settings are
automatically saved.
You can export and import current writing profiles to and from files using Tools>Import
and Tools>Export menu items or tapping on either icon in the toolbar. The writing profile
files have .lss extensions.
If you accidentally enter erroneous settings, you can tap Tools>Use Original Settings or
the toolbar icon to restore the factory defaults.
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Letter shape settings are stored separately for each configuration. Depending on the
language of the recognition engine, letter shapes may appear differently.
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Part Five: PenCommander Reference
PenCommander allows you to launch pre-recorded, user-defined commands
(PenCommands). PenCommander features are available only while CalliGrapher is in
Recognition mode.

What is a PenCommand?
A PenCommand is a sequence of instructions that are performed when a command is
called. Each PenCommand has a name. The name can be any sequence of ASCII symbols
up to 11 symbols. It cannot start with ‘#’ or ‘*’. Examples of correct PenCommand names
include: “select”, “address”, “sel”, “phones”, “spell”, “date”, “news”, “mail”, and
“a23”. Incorrect names include: “my_home_address” (too long), “#account” (starts with
‘#’), and “*test” (starts with ‘*’). PenCommand Names are case insensitive. For example,
“BTW”, “Btw” or “btw” are all recognized as the same name.
There are various categories of elementary instructions that can be used to build
PenCommands. For example, “type predefined text”, “start program”, “delay
execution”, “call user defined function”, “open CalliGrapher’s menu” etc.
Examples of PenCommands:
 Add name, address, and phone number to the current text of a document;
 Insert special symbol (e.g. ©, ®, ¥, ™…) to the text;
 Select all text in the current document and copy it to the clipboard;
 Open a spreadsheet file, e.g. “PHONES.XLS”;
 Create a new mail message;
 Open “System” item in Control Panel;
 Print the current document;
PenCommands are written in PenCommander Script. A simplified form of PenCommand is a
“Text Only” command. To create and edit Text Only PenCommands, you do not need to
know the scripting language. It is highly recommended that you confine yourself to Text
Only PenCommands at the first stage.
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Launching PenCommands
Make sure the CalliGrapher is in Recognition Mode. To launch a PenCommand, write and
encircle its name:

PenCommand

Result

PenCommander execution process
PenCommander interprets instructions from the definitions of its commands one by one
until the end of the definition. Some instructions can return a non-success return code
(e.g. “Load library”, “Ask variable” etc.), in which case the execution of a PenCommand
interrupts and the error handler instruction is performed (if defined).

Text Only PenCommands
The simplest form of PenCommand enters a predefined or user-defined text into the
current document. Such commands are called “Text Only” PenCommands. The predefined
text can contain any printable symbols as well as tabulations and new-line symbols.
Following are some examples of Text Only PenCommands:
PenCommand “sign”
Name:
sign
Comment:
// My signature
Text:
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John Smith
Vice President & General Manager
AnySoft Inc.
Tel. (408) 555-1212
E-mail: john@anysoft.com

PenCommand “addr”
Name:
addr
Comment:
// my address
Text:
1234 Stevens Creek Blvd.,
Cupertino, CA 95014

PenCommand: “sinc”
Name:
sinc
Comment:
// sincerely yours
Text:
Sincerely yours,
John Smith

You do not need to know the PenCommander script language to create and edit Text Only
PenCommands. The PenCommander Editor has a dedicated Text Only Mode to build such
commands, as described below.

Building PenCommands
All information about existing PenCommands is stored in the file PENMACROS.MCR, which is
located in the CalliGrapher folder. PenCommander Editor is the program that allows you
to edit this file by altering, adding or deleting PenCommands.

Starting the PenCommander Editor
To start PenCommander Editor, either tap on the PenCommander icon from with the
Start/Programs dialog, or with CalliGrapher running tap on the PenCommander icon in
the toolbar, or run the PenCmd.exe application. The PenCommander Editor dialog box will
appear:
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PenCommander Editor Dialog box
PenCommander Editor Buttons
to create a new PenCommand. Depending on the mode selected you will be
 Tap
presented with either PenCommander Text Editor dialog or PenCommander Script
Editor dialog.
 Click on a PenCommand name to select it and then tap
 Tap

to delete the selected command.

 Tap

to view text-only commands (text mode)

 Tap

to view all the commands (advanced mode)

 Tap

to enable or

to change it.

to disable the selected command.

From the Tools menu you can perform the following:
 Save: Saves all your PenCommand changes
 Export: Saves a list of PenCommands to a .MCR file
 Import: Loads a list of PenCommands from a .MCR file
Assigning PenCommands to Hardware Buttons
If you tap and hold on a PenCommand in the list, the popup menu appears that allows you
to edit, delete, enable (or disable) the command. Assign to Button command of the popup
menu displays the dialog box that allows you to associate the selected PenCommand with a
hardware button.
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Select a hardware button in the list. Tap the Assign button to assign the PenCommand to
the selected hardware button. If the PenCommand is already assigned to the selected
button, the Reset button allows you to restore the original action of the hardware button.

Building Text Only PenCommands
The following dialog box will appear as the result of tapping the New PenCommand
Edit PenCommand

buttons in Text Only Mode:

Text
field
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When you edit a PenCommand in Text Only mode you can modify its name (which you will
write to execute the PenCommand), add an optional short description, which is for your
reference only, and text that will be inserted into a document when you execute the
PenCommand.
Note: All symbols you enter in the text field will be pasted in the target document,
including carriage returns, spaces and tabulation.
You can enter new line symbols to the Text field by pressing Enter and tabulations by
pressing [CTRL]+[TAB].
When you are done editing, press OK to save the PenCommand and return to the previous
screen.
Text Editor Toolbar Buttons


- Undo



- Cut



- Copy



- Paste



- Select all



- Delete selected text



- Show Help



- Close dialog box without saving changes

Building Script Pen Commands (Advanced Mode)
The following dialog box will appear as the result of tapping the New PenCommand
Edit PenCommand

buttons in the Advanced Mode:
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Script
field

In Advanced Mode, the PenCommander Script Editor dialog allows you write PenCommand
scripts in addition to just typing text.
When you are done editing, press OK to save the PenCommand and return to the previous
screen. After you finished editing/creating your PenCommand, you can try it on writing its
name and encircling it.
Toolbar Buttons








- Check syntax
- Activate recording of the keystrokes you make on the keyboard. Keystrokes are
inserted in your PenCommands at the current caret position.
- Stop recording
- Insert keyword. This button provides you with menus of useful commands, special
symbols and existing PenCommands, which may be included in your PenCommand
script. This simplifies entry of PenCommand script statements and eliminates the need
to memorize the script language commands.
- Browse for a desired file and insert the full pathname
- Insert coordinates of a screen point. Just tap it with the pen and drag to some
location on the screen. When you lift the pen, screen coordinates of the last position of
your pen will be inserted in the PenCommand script. This is useful if you wish to
emulate mouse clicks from your PenCommand (e.g. simulate click on the Windows
'Start' button).



- Insert PenCommand



- Show context-sensitive Help
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- Close dialog box without saving changes

Insert filename example.

Insert Coordinates example

Accessing context-sensitive help
You can access the PenCommander Scripting Language reference directly from the
PenCommander Script Editor. To view help information for a specific special symbol,
variable or command, place the cursor on the desired keyword, then tap the
button.
The Help window will appear displaying the information about the selected keyword. If the
selected word is not a PenCommander keyword, the default help information about the
PenCommander Script Editor dialog box will appear. See images below for examples.
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PenCommander Script Language
PenCommand Definition (extension) describes the sequence of instructions comprising the
command. Its format:
<CommandID_1>[Parameters1] <CommandID_2>[Parameters2] …
<CommandID_N>[ParametersN]
Command_X – command identifier ( e.g. “#type”, “#start”, “#delay”)
ParametersX – parameter string, which consists of ASCII text and special
symbols;
<>- angular brackets are part of script syntax for commands and special
symbols ;
[ ] – square brackets mean optional element;

Command ID and special symbol names are case insensitive.
Examples of single-instruction PenCommand Definitions include:
<#start>pword “\My Documents\phones.doc”
with \My Documents\phones.doc file);

(start Pocket Word

<#type>Sincerely yours,<*return><*tab>John
then type “John” on new line after tabulation).

Application

(type “Sincerely yours,”,

The last example includes two special symbols <*tab> and <*return>.
New line symbols (CR-LF) in script text are ignored, you can use them anywhere to make
text more easy readable, e.g. the example above can be written this way:

<#type>Sincerely yours,<*return>
<*tab>John

To insert the symbol “<” into the parameter string, write “<<”, for example:
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<#type>sometimes 1<<2

(type “sometimes 1<2”)

Some examples of more complex PenCommand definitions:
<#macro>all (call PenCommand with name “all”;
<#delay>1000 then make delay for 1 sec.;
<#corr> then open CalliGrapher’s Corrector Window);
<#askstr>Enter program file name: (ask program name through dialog and place
answer to string <#start><*str> then execute program with name from the
string variable)

The last example uses “string variable”. Variables will be discussed in the next section.

Variables
There are some internal variables, which can be used in the parameter area of a
PenCommand script:
 10 text strings up to 256 symbols length (<*str0>-<*str9>)
 10 one character symbols (<*symb0>-<*symb9>)
 10 integers (<*int0>-<*int9>)
You can omit index digit 0 (e.g. <*str> is equal to <*str0>). Examples of variables usage
include:
<#macro><*str>(perform PenCommand with name from string0);
<#type>Sincerely yours,<*return><*str8> (type “Sincerely yours,”, then type
string8 content on the next line).
<#Start>”C:\Program Files\Apps\<*str3>.exe”
(start program with name from
string3, which is located in C:\Program Files\Apps\ folder);

Commands for variables manipulation:
<#SetStr>, <#SetSymb>, <#SetInt>

(set value to appropriate variable);

<#AskStr>, <#AskSymb>, <#AskInt>

(show dialog box to ask variable value);

Special Symbols
Special symbols to use in <#Type> command only.
<*ctr_dn>
<*ctr_up>
<*alt_dn>
<*alt_up>
<*shift_dn>
<*shift_up>
<*bksp>
<*tab>
<*return>
<*right>
<*left>
<*down>
<*up>

-

Press [CTRL]
Release [CTRL]
Press [ALT]
Release [ALT]
Press [SHIFT]
Release [SHIFT]
Type [BACKSPACE]
Type [TAB]
Type [ENTER]
Type [RT ARROW]
Type [LEFT ARROW]
Type [DN ARROW]
Type [UP ARROW]
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Type
Type
Type
Type
Type

[HOME]
[END]
[PG DN]
[PG UP]
[ESC]

Examples:
<#type><*ctr_dn>z<*ctr_up> (Type [CTRL]+[Z])
<#type>Sincerely yours,<*return>John
line + “John”)

(Type “Sincerely yours,” + new

Commands
This section lists available commands:

General commands
Comment
 Keyword: <#>
 Parameters: Any text string (symbol ‘<’ should be doubled)
 Action: None.
There is another form of Comment-command: you can place double slash “//” in the
beginning of line. In this case whole following line will be treated as comment, for
example:
<#> This is the comment.
// PenCommand to place the address

Type
 Keyword: <#Type>
 Parameters: Any text string, including Special Symbols and Variables.
 Action: Emulates keyboard activity (e.g. for text input).
 Remarks: Parameter string for this command can include Special Symbols (e.g.
“Escape”, “Home”,”BackSpace” etc).
Examples:
<#type>John Smith type “John Smith”)
<#type><*str> (type String0
variable)
<#Type> My address:<*return> (type “My Address: 1234 California
Street,<*return> 1234 California Street, Cupertino, CA 5014<*return>
Cupertino, CA 95014”)
<#Type><*ctr_dn>c<*ctr_up> (type Ctr+C)
<#Type><*alt_dn>f<*alt_up>o {type Alt+F and then type ‘o’)
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<#Type><*alt_dn>T<*alt_up><*down><*down><*return> (type Alt+T ; then twice
‘cursor down’; then ‘Entr’)

Execute program (Open file)
 Keyword: <#Start>
 Parameters: Path to the file to open or execute + [optional parameter string for
starting program]
 Action: Start program
 Remarks: If file name includes spaces – use quotes. Program parameters should be
separated from program name by the space symbol.
For example:
<#Start>c:\windows\notepad.exe (start Notepad.exe)
<#Start>notepad (start Notepad.exe)
<#Start>notepad “C:\My Documents\phones.txt”
“C:\My Documents\phones.txt” file)
<#Start>“C:\My Documents\test.txt” (open
(non-CE))

(start Notepad.exe and open

“C:\My Documents\test.txt” file

<#Start>pxl \LoanCalculator.pxl (Open LoanCalculator.pxl in Pocket Excel)

Execute PenCommand
 Keyword: <#Macro>
 Parameters: Name of the PenCommand to execute.
 Action: Execute a PenCommand.
 Remarks: The next PenCommand will be processed after this step of execution. Not
more than 10 PenCommand execution levels can be nested. No recursion is allowed.
For example:
<#Macro>all (perform the PenCommand ‘all’)
<#Macro><*str3> (perform the PenCommand with its name taken from the
variable String3)

Delay
 Keyword: <#Delay>
 Parameters: Time interval for delay (in milliseconds)
 Action: Pauses the script execution for a specified time
 Remarks: This command usually is used to give the system some time to perform the
previously asked action before performing the next script command (e.g. wait after
<#start> command).
For example:
<#Delay>1000

(wait 1 second)
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Rotate Screen
 Keyword: <#ScrMode>
 Parameters:

0 - Portrait mode
1 - Right-handed landscape mode
2 - Upside-down portrait mode
3 - Left-handed landscape mode
none - rotate to the next mode

 Action: Rotates Pocket PC screen to a certain position.
 Remarks: This command is only supported on the latest models of Pocket PC 2003 that
natively support landscape mode. Some older devices also could be upgraded to the
latest version of the Microsoft Windows Mobile software that supports screen rotation.
If you are not sure whether your Pocket PC supports landscape mode, contact the
manufacturer of the device.
For example:
<#ScrMode>

(rotate to the next mode)

Show Message Box
 Keyword: <#ShowMsg>
 Parameters: Text to show in the message box.
 Action: Shows Message Box with the given text.
 Remarks: You can use symbol sequence ‘\n’ to force the new line in the message.
For example:
<#showmsg>Ready to go.
<#showmsg>Error while performing

the PenCommand <*str7>.

Set Error Handler
 Keyword: <#DoIfErr>
 Parameters: Name of a PenCommand to execute.
 Action: Save name of a PenCommand as the error handler name.
 Remarks: This command sets the PenCommand name as an error handler. If the
subsequent instructions in current the PenCommand definition return an error code
(e.g. <#LoadLib> could not load user library), than the error handler PenCommand will
be executed (if defined). This setting is good only for the PenCommands currently
being executed and has no effect upon the nesting ones.
For example:
<# DoIfErr >%loaderr (Set error handler PenCommand name to “%loaderr”
<#LoadLib>mylib.dll Load library0 “mylib.dll”
<# DoIfErr >%caller Set error handler PenCommands name to “%callerr”
<#CallLib>myfunc Call user defined
procedure “MyFunc” from library0
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<# DoIfErr > Turn of error handling
<#FreeLib> Free Library0
)

(no handling defined)

Variable Manipulation Commands
Set String Variable
 Keyword: <#SetStr0> - <#SetStr9>
 Parameters: String to place to the string variable
 Action: Set the appropriate string variable to given value.
 Remarks: Variable index 0 can be omitted.
For examples
<#SetStr>John Smith

(Set String0 to the value

<#SetStr4><*str3>\myfile.txt
“\myfile.txt” to string4).

“John Smith “)

(Set String4 to the concatenation String3 and

Set Symbol Variable
 Keyword: <#SetSymb0> - <#SetSymb9>
 Parameters: Character to place to the symbol variable
 Action: Set the appropriate symbol variable to given value.
 Remarks: Variable index 0 can be omitted. Only the first symbol from Parameters area
is using.
For example:
<#SetSymb> ™ (Set Symbol0 to ‘™’)
<#SetSymb2>N (Set Symbol2 to ‘N’)

Set Integer Variable
 Keyword: <#SetInt0> - <#SetInt9>
 Parameters: Number to place to the integer variable
 Action: Set the appropriate integer variable to given value.
 Remarks: Variable index 0 can be omitted.
For example:
<#SetInt>1000 (Set Integer0 variable to 1000)

Ask String Variable
 Keyword: <#AskSymb0> - <#AskSymb9>
 Parameters: Title text to show in the dialog box.
 Action: Show dialog box for string value input. Set the appropriate string variable to
given value.
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 Remarks: Variable index 0 can be omitted. Current value of variable will be shown in
the input field of dialog box.
For example:
<#AskStr4>Please enter program file name:

Ask Symbol Variable
 Keyword: <#AskSymb0> - <#AskSymb9>
 Parameters: Title text to show in the dialog box.
 Action: Show dialog box for symbol value input. Set the appropriate symbol variable to
given value.
 Remarks: Variable index 0 can be omitted. Current value of variable will be shown in
the input field of dialog box.
For example:
<#SetSymb4>k (Set default value – “k”
<#AskSymb4>Enter first letter for searching:
variable).

Place result to Symbol4

Ask Integer Variable
 Keyword: <#AskInt0> - <#AskInt9>
 Parameters: Title text to show in the dialog box.
 Action: Show dialog box for integer value input. Set the appropriate integer variable to
given value.
 Remarks: Variable index 0 can be omitted. Current value of variable will be shown in
the input field of dialog box.
For example:
<#AskInt2>Please, Enter Zoom Percent: (Place result to Integer0 variable)

User-Defined Procedure Commands.
Load User Library (DLL file)
 Keyword: <#LoadLib0> - <# LoadLib9>
 Parameters: Path to user dll-file to load.
 Action: Loads dll-file.
 Remarks: Library index 0 can be omitted. If file name includes spaces – use quotes.
For example:
<#LoadLib>\mylib.dll
<#LoadLib>”\my documents\mylib.dll”
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<#LoadLib><*str8>

Free User Library
 Keyword: <#FreeLib0> - <#FreeLib9>
 Parameters: Ignored.
 Action: Frees dll-file.
 Remarks: Library index 0 can be omitted.
For example:
<#LoadLib>
<#LoadLib3>

Call Procedure from User Library
 Keyword: <#CallLib0> - <#CallLib9>
 Parameters: Calling procedure name [optional parameters string for procedure].
 Action: Calls user defined procedure from proper DLL-file.
 Remarks: Library index 0 can be omitted. Procedure name and parameters string must
be separated by the space symbol. User defined procedure has access to internal
PenCommand variables and can change them.
For example:
typedef TCHAR MCR_STRINGS_TYPE[10][256];
typedef TCHAR MCR_SYMBS_TYPE[10];
typedef INT
MCR_INTS_TYPE[10];
typedef _declspec(dllexport) BOOL UserProcName
(MCR_STRINGS_TYPE *pStrings,
MCR_SYMBS_TYPE *pSymbs,
MCR_INTS_TYPE *pInts,
TCHAR *pParmStr,
LPARAM lParam);

Parameters pStrings, pSymbs, pInts are the pointers to arrays of PenCommand variables.
The variables may be read or changed by the function.
Parameter pParmStr points to optional parameters string.
Parameter lParam is reserved, currently not used.
Result: non-zero for OK.
Sample user-defined procedure
PenCommand Name: TIME
// PenCommand for typing the current Time
<#LoadLib>D:\Cgr98\macrousr.dll
(Load User Library)
<#CallLib>UsrPutTimeToStr 5 0 (Call user defined function UsrPutTimeToStr,
which puts current time in American style to String5 variable)
<#FreeLib>
(Free User Library)
<#Type> <*str5>
(type String5 content)
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User-defined function text:
_declspec(dllexport) BOOL UsrPutTimeToStr(
MCR_STRINGS_TYPE *pStrings,
MCR_SYMBS_TYPE *pSymbs,
MCR_INTS_TYPE *pInts,
TCHAR *pParmStr,
LPARAM lParam)
{
int
iStrNum = 0; //target string number
int
iFormat = 0; //time format (0-American; non-0 - European)
SYSTEMTIME st;
//struct for GetLocalTime()
//read target string number and time format type
if(pParmStr==0 ||
_stscanf(pParmStr, TEXT("%d %d"), &iStrNum, &iFormat)<1 ||
iStrNum<0 || iStrNum>9)
return FALSE;
GetLocalTime(&st);
if(iFormat==0)
{ //American time format
TCHAR AmPm;
int
iHour;
if(st.wHour>=12)
AmPm = 'P';
else
AmPm = 'A';
if((iHour=st.wHour%12)==0)
iHour = 12;
wsprintf((*pStrings)[iStrNum], "%d:%02d %cM.", iHour,
(int)st.wMinute, AmPm);
}
else
{ //European time format
wsprintf((*pStrings)[iStrNum], "%d:%02d", (int)st.wHour,
(int)st.wMinute);
}
return TRUE;
}

A full source code of the macrousr.dll can be download form PhatWare’s web site at
http://www.phatware.com/calligrapher/cgrreskit.html.

Mouse commands
Click Mouse Button command

 Keyword: <#BtnClick>
 Parameters: Two integer values separated by comma that specify X and Y mouse
coordinates relative to the upper-left corner of the screen in pixels.

 Action: Emulates a single left mouse button click at the specified coordinates.
 Remarks: This command can be used to emulate a left button down command at the
specified location. The keyword should be followed by 2 integer values which specify X
and Y coordinates relative to the upper-left corner of the screen. The mouse click
message is posted in the foreground window.
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Double-click Mouse Button command

 Keyword: <#DblClick>
 Parameters: Two integer values separated by comma that specify X and Y mouse
coordinates relative to the upper-left corner of the screen in pixels.

 Action: Emulates a left mouse button double-click at the specified coordinates.
 Remarks: This command can be used to emulate a left button double-click command
at the specified location. The keyword should be followed by 2 integer values which
specify X and Y coordinates relative to the upper-left corner of the screen. The mouse
double-click message is posted in the foreground window.
Press Mouse Button command

 Keyword: <#BtnPress>
 Parameters: Two integer values separated by a comma that specify X and Y mouse
coordinates in pixels relative to the upper-left corner of the screen.

 Action: Emulates a left mouse button down command at the specified coordinates.
 Remarks: This command can be used to emulate a left button down command at the
specified location. The keyword should be followed by 2 integer values which specify X
and Y coordinates relative to the upper-left corner of the screen. The mouse button
down message is posted to the foreground window.
Release Mouse Button command

 Keyword: <#BtnRlse>
 Parameters: Two integer values separated by a comma that specify X and Y mouse
coordinates in pixels relative to the upper-left corner of the screen.

 Action: Emulates a left mouse button release (up) command at the specified
coordinates.

 Remarks: This command can be used to emulate a left button up command at the
specified location. The keyword should be followed by 2 integer values which specify X
and Y coordinates relative to the upper-left corner of the screen. The mouse button up
message is posted to the foreground window.

CalliGrapher commands
Show/Hide CalliGrapher keyboard
 Keyword: <#Kbrd>
 Parameters: Ignored.
 Action: Toggles the display state of the CalliGrapher soft keyboard.
For example:
<#Kbrd>
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Show/Hide CalliGrapher Custom keyboard
 Keyword: <#CustKbrd>
 Parameters: Ignored.
 Action: Toggles the display state of the CalliGrapher Custom keyboard.
For example:
<#CustKbrd>

Show/Hide CalliGrapher toolbar
 Keyword: <#Toolbar>
 Parameters: Ignored.
 Action: Toggles the display state of the CalliGrapher toolbar.
For example:
<#Toolbar>

Show CalliGrapher Options
 Keyword: <#Options>
 Parameters: Ignored.
 Action: Shows CalliGrapher Options Dialog Box.
For example:
<#Options>

Show CalliGrapher Corrector Window
 Keyword: <#Corr>
 Parameters: Ignored.
 Action: Opens CalliGrapher Corrector Window.
 Remarks: This command has the same result as “Correct”-gesture in CalliGrapher.
For example:
<#Corr>

Start Letter Shape Selector
 Keyword: <#Shape>
 Parameters: Ignored.
 Action: Starts CalliGrapher Letter Shape Selector program.
For example:
<#Shape>
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Start PhatPad
 Keyword: <#PhatPad>
 Parameters: Ignored.
 Action: Starts the PhatPad application (if installed).
For example:
<#PhatPad>

Set Recognition Mode
 Keyword: <#ScrMode>
 Parameters:

0 - Normal mode
1 - Capitals mode
2 - Numeric mode
3 - Internet mode
none - selects next recognition mode

 Action: Changes CalliGrapher recognition mode (mixed, capital, numeric, internet).
For example:
<#ScrMode>

(switch to the next recognition mode)

Set Recognition Direction
 Keyword: <#RecDir>
 Parameters:

0 - Normal orientation
1 - Device turned right 45 degrees
2 - Device turned right 90 degrees
3 - Device turned 180 degrees
4 - Device turned left 90 degrees
5 - Device turned left 45 degrees
none - selects next direction

 Action: Changes CalliGrapher recognition direction (screen orientation).
For example:
<#RecDir>

(changes to the next recognition direction)

Select CalliGrapher Configuration
 Keyword: <#Cfg>
 Parameters:

Configuration name
(if name is not given the next configuration is selected)

 Action: Switches active CalliGrapher configuration.
For example:
<#Cfg> English

(switch to the “English” configuration)
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Script Samples.
Below are a few useful samples of PenCommand definitions:
Select all text (for Word)
PenCommand name: ALL
// Select all text (Ctrl+A)
// this PenCommand works in Word
<#type><*ctr_dn>a<*ctr_up>

You can easy implement some [CTRL]+… PenCommands, such as Copy ([CTRL]+[C]), Cut
([CTRL]+[X]), Undo ([CTRL]+[Z]), Paste ([CTRL]+[V]) etc.
Select all text (for most text edit apps)
PenCommand name: ALL
//Select

all text

<#Type><*ctr_dn><*home><*shift_dn><*end><*shift_up><*ctr_up>
Open Corrector Window
PenCommand name: SPELL
// Open Corrector Window for all current document
// first: select all text (see the PenCommand in sample2)
<#Macro>all
// then open corrector window
<#corr>

Open Favorite Internet WEB page
PenCommand name: WEB
// Open CalliGrapher WEB page

<#Start>iexplorer http://www.phatware.com/
Open CalliGrapher Help
PenCommand name: CHELP
// Open CalliGrapher help
<#Start>iexplorer \windows\calligrapher.htm

Call PenCommander Editor
PenCommand name: CHELP
// Call PenCommander Editor
<#Start>”\program files\calligrapher\pencmd.exe”

Open Inbox
PenCommand name: INBOX
//open inbox
<#Start>pMail
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Open Pocket Excel Spreadsheet
PenCommand name: LOAN
// Call Loan Calculator
<#Start>pxl ”\My Documents\LoanCalculator.pxl”

Place the ‘™’ Symbol into Text
PenCommand name: TM
// Place the ‘™’ symbol into text.
<#Type>™

CalliGrapher Reserved PenCommands
There are three PenCommand names, which are reserved for CalliGrapher usage:
 @CgrOnInit
 @CgrOnClose
 @CgrVars
@CgrOnInit.
@CgrOnInit is executed (if present) by CalliGrapher while PenCommander PenCommands
are loading to the system. You can place any commands within this PenCommand that you
wish executed at that time.
For example:
//do it on init
<#ShowMsg>PenCommander is ready
<#loadlib3>”\Program Files\myfolder\usrmacro.dll”

@CgrOnClose.
@CgrOnInit is executed (if present) by CalliGrapher while closing PenCommander. You can
place any commands within this PenCommand that you wish executed at that time.
For example:
//do it on close macros
<#ShowMsg>PenCommander is off
<#FreeLib3>”\Program Files\myfolder\usrmacro.dll”

@CgrVars.
This PenCommand is automatically generated by CalliGrapher when PenCommander is
closing. It allows to CalliGrapher to save and restore variable values. Do not correct this
PenCommand manually.
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